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This manual addresses skilled
personnel with PLC
know—how and
technicians who are
familiar with basic
PLC programming.

9

The manual will guide you through

your first PLC steps with CL150.
This manual introduces the
Bosch CL150 controller and
provides the know—how
required for handling and
utilizing the CL150.

It shows you how to commission
the CL 150 and start the
programming tool WinSPS.
You will be familiarized
with the PLC instructions
of the CL150 and use
them in a WinSPS
sample program.

Testing and debugging the
program after it has been
created is often a rather

time—
consuming aspect in PLC
programming.

This manual will show you
how to test and debug your
program directly within the
programming environment
in combination with

the CL150.

The symbolic and structured
programming methods
presented in this
manual show you how
to efficiently utilize
the controller.
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The CL150 is an economic and
compact controller of the Bosch
Programmable Logic Controllers
(PLC) series. The CL150 is
small, efficient and can be used
for fast controlling tasks, for
example in the automotive
range, small conveying systems
and in systems for the printing
and paper industry.

This controller represents a cost
efficient solution for even the
smallest systems. With an
enhancement of the decentralized
I/0 system components, or in a
network as decentralized
controller, it can handle simple
tasks in assembly lines as the unit
offers very good networking
capabilities and a large

The CL150
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ST

CL150

Basic version of the compact
controller with 8 inputs and
8 outputs

Equipment variations with analog
I/0s and connection to Fieldbus
systems

Connection for the components
of the I/O system B~IO
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E
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instruction scale. The CL150 is
available in a number of version
for an optimal and efficient
adaptation to the tasks at hand:
dependent on the equipment,

it comes with supplementary
analog inputs and outputs or
with optional operation within

a Fieldbus network.

CL1s
‘070080502

BOSCH

WinSPS

Complete programming package
for Windows95, 98 and NT

Project management,
creation of programs,
Online testing, documentation

Programming in IL, LD, FUD and
SFC in accordance with
DIN EN 61131

Multiuser functions for working in
project teams

Multitasking for parallel program
processing

Single-user and networking
solutions

Extensions

Customization of the given
1/0 structure with modules of
the system B~IO M-

In-line operation with a
maximum of 16 modules




Basic equipment of the CL150

The compact controller

e is available in several
versions with analog and
digital I/Os, an additional N Clisg

107005050,

serial interface and a
Fieldbus extension,

e is equipped with an
expansion slot for
1I/0 modules of the
B~IO system and

¢ expandable with up to
16 modules.

The controller has two internal A battery buffers the controller’s

memories - one of 64 KB RAM internal RAM against power

and one 64 KB Flash EPROM - failure and switching off, thus

which can be used individually protecting the remanent areas for

or combined. markers, timers, counters, data
fields and data modules.

B~I0 modular, available I/Os

Digital inputs 8 DI 16 DI 16 DI-3
8 inputs 16 inputs 16 inputs
Digital outputs 8 DO 16 DO 8 DO/2A 8DOR
8 outputs 16 outputs 8 outputs 8 relay-outputs
05A 05A 20A 2,0A
Combination module, 8 DI/DO
digitale 1/0 8 connections, bit utilization as 1/0
05A
Analog I/O 4 Al_UI 4 Al_UIT 4 A0 | 4A0_U
4 inputs, 4 inputs, 4 outputs, 4 outputs,
12 bit 14 bit 16 bit 12 bit
0-5V,0-10V, 0,1V, +1V, = 0-10V,t10V

0,5V, 10V 10V



CL150

The CL150 has
e 8 digital inputs 24 VDC,
¢ 8 digital outputs
24 VDC/0.5 A,
e 2 fast 32-bit counters or
¢ 3 interrupt/alarm inputs,
® one programming interface

V24, BUEP19E protocol.
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CL151

The CL151 has

16 digital inputs 24 VDC,

8 digital outputs

24 VDC/0.5 A,

2 fast 32-bit counters or

3 interrupt/alarm inputs,

Real-time clock,

one programming interface

V24, BUEP19E protocol,

e a second serial V24
interface, 20 mA passive,
protocol BUEPI9E and
BUEPO3E.

The basic devices

Fieldbus interface

The CL150 and CL151 are
available with the following
Fieldbus interfaces:

e PROFIBUS-DP,

¢ CANOpen,

e InterBus-S and

e DeviceNet.

All devices with Fieldbus

interface are equipped with

the following features:

¢ 8 digital inputs 24 VDC,

o 8 digital outputs 24

VDC/0.5 A,

2 fast 32-bit counters or

3 interrupt or alarm inputs,

Real-time clock,

Programming interface V24,

protocol BUEP19E

e CL151: second serial
interface and BUEPO3E
protocol

e Fieldbus interface.



of CL150 and CL151
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CL150A

The CL150A has
¢ 16 digital inputs 24 VDC,
e 8 digital outputs
24 VDC/0.5 A,
e 2 fast 32-bit counters or
¢ 3 interrupt/alarm inputs,
¢ 2 analog inputs 0-10 V,
10 bits,
e 1 analog output + 10 V, 0-20
mA, 12 bits,
e Real-time clock,
® one programming interface

V24, BUEP19E protocol.
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CL151A

The CL151A has

e 16 digital inputs 24 VDC,

e 8 digital outputs
24 VDC/0.5 A,

o 2 fast 32-bit counters or

¢ 3 interrupt/alarm inputs,

¢ 2 analog inputs 0-10 V,
10 bits,

¢ 1 analog output + 10 V,
0-20 mA, 12 bits,

e Real-time clock,

¢ one programming interface
V24, BUEP19E protocol,

e a second serial V24
interface, 20 mA passive,
protocol BUEPI9E and
BUEPO3E.
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CL150 Controller Installation Z 1
in the switchboard cabinet @
¢ Mounting on rail or with
screws
e Vertical, horizontal or lying
mounting
=
: 2
Connecting and wiring
L1
N
PE =
i “ E==
2_V L -
= O ————
oV 124V Z ©
0123456567012346867 =01234567
2 3330003500000 ooty [| Baooobon
= ooooooodooooooon :DDDH oooooon
uDDDDDDDaDDDDDDDDMDDD[]u u DDDDDDD}J
T
X
e Fuse the voltage supply on ¢ Always use a power supply
primary side with safe separation compliant 56,
¢ Connect the CL150 controller with DIN EN 60 742. 24V Sensor
to the protective ground Additional protective measures
system PE by installing it on a are not required if conforming.
grounded mounting rail e Wire the 24-V lines separately
¢ Dimension the voltage supply from lines carrying higher
for maximum current load voltages.
¢ Maximal permitted voltage The modules are supplied with
fluctuation +20%, -15% removable plug terminals.

Consequently there is no need
to disconnect the wiring when
replacing the controller or a
module.

10



Expanding the CL 150 with I/0 modules

Switch off the signal voltages and
the external power supply of the
controller before you connect
modules.

When handling the controller

or modules, make provisions

for sufficient protection against
electrostatic discharge that might
destroy the controller or the
module.

Manual addressing

Automatic addressing
The CL150 operating system automatically assigns the start
addresses to all connected I/O modules.

The module address is dependent on the sequence it is
arranged in.

Start address for input modules is 2, for output modules it is 1.

The data length of the module is taken into consideration; word
length modules are assigned to an even-numbered address.

Modules equipped with both inputs and outputs have the same
input/output start addresses.

I o ——y = The start address of all modules
/B oo - is customized in the WinSPS
O molepr e o j software.
o e ] e _ lsoo
E‘Mll g0 e | ennsas
e . P In the WinSPS program, call the
_ E .
0 Sl editor and select the menu
T = Jowers = “Edit > I/O configuration (OB3)".
..... M |2 M D]
..... 13 .. Uz
----- o T - .o3 The PLC program evaluates the
""" — P signal connections of and 8-input
..... . - |05 gn pu
----- | :; S 2? module, for example, with start
Iﬁ:: P :: o0 address E2 via operand addresses
..... 1o .. 09
_____ = oo 12.0 to 12.7.
..... n= ;I - ot ;I
™| Module check Dnl— PLC sontents [ modules ordy
T Help | Bit |  Label | PFintlabel |

Advantage of manual addressing:

The number of connected
modules is fixed, that is, a
disconnected module is
recognized as error.

11
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The program WinSPS

WinSPS at a glance

WinSPS - Project settings Default settings
~Directorie z0 | kB Determining data related to
Project path: Netwark ¥ the project and controls
[C\PROGRAM FILES\BOSCHWINSP | .| P adlis [FrROGRAMIFXD =] e Project path and names,
Library path: Dta o = ¢ Controller types
["Frogram Files"BoschiWinSPS = ' e File names
Symbal file: IPHDJECT.SXS VI .
Pt e Interface configuration
— Project Iﬁ
e PROJECT.TXT = .. .
Project name: Ve Customlzmg the WIIISPS
[sTER1.PRY <] Hewproject . | Sequ. Eunction Chart | | startup parameters
Cantraller: Structured Text (ST: I 'I Licensing information
IEL150.150 'l Mew controller ... | Connection ta PLE:
— Setting JCOM219200E.8.1, =l Test |
Parameter | Author | Canfigurator |
‘ Editar | i‘ Manitar E Exit | icense ... | @ Help |
Editor IProject: S1EPTACLISU] - PRUGHAM1 PXU - WinSP5 Editor - CL15U [Build 13231
Fie Edt Wew (ooibod Contol Change Help
Creating the PLC program
SFC ST
with the %ﬁﬂﬁf’n &“d‘llgl B &
Inst 4 List (IL) ng Data Tedt  Save Paste  Lo3Mo Mmaa. i LD FBD
® nstrucuon Lis
) . Ipmgraml.pxn vI MMM HrFrmrE fIEI =
¢ Function diagram (FBD)
e Sequential Function Chart Newwork No.: 1| [Switch waffic ights w red B 0]
(SFC) © Author Riedel Company® Riedel i'
: Version: 1.0 Date: 00.01.2001

¢ Contact plan (LD)

Interface test

Transferring the programs
Managing PLC memory
utilization

Creating symbol lists and
cross-reference lists
Printing out all PLC
configuration data

IFProject: 51TEPTACLISUL -
bie Edt Wiew Uonbiol Lhange Help

PHUGHAM1 FXU

: Program module file

AN marker for demand :marker_for_demand off
S —traffic lights red ctraffic lights red
-
1 3
HO.0 marker_for demand
Qo.o traffic_lights red
[Meru area for command |

- WinSHS Momtor - CL15U [Build 1323]

Monitor

Prog Data Tewt Operand D-Field

Ipmgraml.pxn o F AL % Lox

£ O AF [T o G, &0. B

Force

Edit

Network No.: | |Swllch traffic lights to red

© huther-
; Version:

Riedel
1.0

: Program module file

sic 51 Testing the PLC program with
Diagan - |1 the CL150
Ll @ Monitoring
I the running PLC
. =] * the program status
S A :| e data changes
e the I/0 image

| Retrieving module calls

| Changing the switch state of
inputs, outputs and markers
in the PLC.

AN marker for demand il
S —traffic_lights red 10Q
-
II I L3
HO N narker_for_demand
Qo.o traffic_lights_red

LT

13



Installing WinSPS

Valuable

information about

WinSPS

Removing
WinSPS from
the hard disk
drive, save for
the licensing
information

Fﬁ
i7d
Fragramming

handb... CL150

14

Starting
WinSPS

Ordering a
WinSPS license
per fax

28

nlnztall WinSPS

PDF files of the
controller
programming
manuals and
information on
SFC and PLC
programming

Start the installation program
"SETUP.EXE” from the
CD-ROM.

You can select 'SETUP.EXE”
with the Explorer and start it
per mouse click. Follow the

instructions of the installation

program.

The installation program unpacks
and copies all files to the hard
disk drive. The adjacent icons
will be created in the "Bosch”

program group.

You do not require a license in
order to be able to work with
WinSPS and the CL150.
However, if you want to use the
program in other controllers also
you must order a license key
from Bosch.

Uninstalling WinSPS

Always remove a licensed
WinSPS version with the
program "Uninstall WinSPS”.
Initialize it with a click on the
corresponding icon in the Bosch
program group. Do not use the
Explorer to remove WinSPS.
This will delete all existing
licensing information.

To recognize the license key, the
new WinSPS software must be
installed in the same directory as
the previous version.

Programming license

You do not require a license in
order to be able to work with
WinSPS and the CL150.
However, if you want to use the
program in other controllers as
well you must order a license key
from Bosch. You can obtain
licenses free of costs and for
time-limited demo versions, as
well as for full versions for
single-user and networking
applications.

You can direct your license
application to Robert Bosch
GmbH by fax. A dialog box that
is opened with the initial startup
of WinSPS offers you infor-
mation on the procedure.

All features of the WinSPS
software will be fully enabled
after you have entered the Bosch
license key.

The license is valid only for the
installed WinSPS program. If
you want to use a second
WinSPS installation, you must
either order another license or
transfer the existing license to the
second version. This prevents a
startup of the current WinSPS
installation until you have
returned the license to it.

You can use the "License” button
in the WinSPS program window
"WinSPS-project customization”
for license transfer and changes.



Connecting the PC to the CL150

PLC PC
6 1 1 6
ogl2_RxD A 230
ool D 3lg0
oI5 GND 51>~ 9
Shield

Customizing communication

parameters

The respective interface is
selected in the WinSPS window
"Project settings” -> "Connecting
the PLC via:”. The transfer rate
of the CL150 is set fixed to
19,200 baud.

Interface test

The WinSPS software can

test the function of the data
communication and query the
transfer rate settings. This
interface test is started in the
WinSPS window "Editor”, under
"Controller -> Interface test”.

WinSPS tests the communication
and returns the transfer
parameters found.

UL T ERL 200 l

Connection to PLC:

COMZ2.13200E.8.1,

You can use the Bosch serial
cable K19 (order no.

1070 077 753) to transfer data
between the CL150 and a PC.
Connect the cable to a PC serial
interface COM1 to COM4. The
respective interface is selected in
the WinSPS window "Project
settings” -> "Connecting the PLC

”

via:”.

3l [z

If the data communication is

disrupted,

e check whether the controller
is switched on

¢ and whether all plugs are
properly connected. The cable
should be connected to the
9-pin X31 socket of the
controller and to a PC serial
interface.

o Check whether the PC detects
the serial interface. You must
restart Windows when you
initially use the interface or if,
for example, you swap the
serial interface for the mouse
and the controller connection.
The Windows startup sequence
recognizes active interfaces
and assigns the connections
accordingly.

15



|i Editor i b it E E xit |

ICENZE ...

|2 s |

Enabling
the program

Calling Help

license

figuration

Changing to Changing to Closing the
the editor monitor mode program
In your configuration settings

Starting WinSPS
i you create or select the project

path and name, as well as the

controller name and type. Blocks

and date are created for a

project:

e a program module for the
controller program,

Creating project directories

Project path: Metwark W
IE:\F’HDGH.&M FILES“BOSCHYWINSF J

A directory path for the project

Library path:

The path to the WinSPS program
|E:\F‘rogram Files\BozchyWwinSPS

libraries

Editing controller and project information

Project name, directory name for the | Mew praject ... |
controller and the controller type
CL150

Insert the file names

Froject;

Contraller name: IEL'I a0 Contraller twpe

e the Organization Module
OML1 for starting the PLC
program,

e a Data Module,

¢ a symbol file for the
declaration of blocks and
symbol operands.

IT r- lights

The name of the module initially
programmed in the editor

Program rodule:

[PROGR&MTFX0 =]

Name of a data module

Data module: ID.-'l'-.T_B.-’-'-.LI.F‘XD

=

A name for the project symbol file Syrmbal file:

|F'F|EIJEET.S><S
Call the editor

Files are created after confirmation

File structure in CL 150

EH:l Frogram Files
I__—_H:| Bosch
-3 WinsPs
-3 Tright PR
- B+ CHs0150

16
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WinSPS automatically creates all
required directories after the
query. You can choose names
freely. It is important, however,
that you subsequently enter the
correct names in the symbol file.



The Editor

File editing tools

Save Edit texts

Instructions for
structuring the
network

- CL150 (Build 1323]

Loading the open module and
change to the Monitor view

Select the program—

ming language

Changing to
the monitor

Menu bar bl i
= ] = L 5FC 5T
ot e AFE & 5 E .
Prog. | Data  Sembol  Text Save Find Cut Copy  Past Lo»Mo  Moritar IL LD FED
File selection — Ipmgraml.pxu j = M MR B
Network —  Metwork No.: [1 ISwitch traffic lights to red j ﬂ ﬂ
display :
Author: Riedel Company . Riedel j
; Version: 1.0 Date: 08.01.2001
Input field _ Progran module file
AN —marker_for_demand marker_for demand off
S —traffic lights red straffic lights red
kI ;I_I
mbol I HO.0 narker_for demand
Sy bo Qoo traffic light=s red
window
Status bar —  [Menw arza for command

WinSPS provides the following
files for your program

organization and documentation.

Symbol files for symbolic
addressing and configuring the
PLC program

Text files for comments and
documentation

Operand and fixing files for the
program test

PLC program modules for a

library, for direct implementation

into a PLC program.

Customizing the Editor view
You can switch the symbol bars
and the network display on or off
via menu item "View”. Actuated
menu items are indicated by

WinSPS with a check mark.

17



Creating a program

Customizing the symbol file

In the symbol file you can
declare the symbolic names for
the operand.

Load the symbol file
with the default file

[Project: STEP1ACL150] - PROJECT.SXS - WinSPS Editor - ... =] B3

Symbol name into the editor.

The editor checks the syntax of
all inputs and automatically

File Edit “iew Toolbox Control Change Help

= ; =
x| 0 A B & 5B
Frog. Data | Symbol | Text Save Find Cutt Copy  Paste L
Iproiect.sxs j B

formats error-free entries.

The blocks are assigned the file

name under which they are

stored. You must enter the

following files:

e “org_bau.pxo”, for the
organization module OM1

e “programl.pxo”, for the
program module FCO.

WinSPS also requires the data
module "dat_bau”, because it has
been entered in the default
setting. You do not need to edit
the module at this point.

Symbol file

;o Hodule type in control

N RAM-EPROM ID (R-E), RAM i=s default
: I I -i— ————— Symbolic module neame on disk

OM1 R ORG_BAT ; Zylklische Programmbearbeitung
;OH2 R O OMZCL150; Initialization table

OM5 . E OMS ; Start—up mnodule after power—-on

Function Call modules FCO through FC1l27

FCO.RE  PROGRAML

FC127.R FC127

;‘Da.ta mnodules DMO through DM127

DMO.E  D&T_Bal

‘DH127.R DM127

Thi= i= folloyed by all other operands in any orde

I0.0

ey _for demand
For programming with symbolic o0.0 traffic lights red
operands you declare a symbolic Q0.1 traffic lights green
name in the symbol file for each MO .0 narker_for_demand _|;|
absolute operand such as 10.1 or | >
MO.1. I
Saving the symbol
=T
Save

18




Programming the Organization Module OM1

The Organization Module OM1
is the first program module to be
programmed. Controlling of the
program schedule is a major task
of OM1. The PLC program is
edited in another program

WinSPS relieves you of
standard tasks

The file selection window
displays the name of the open
file.

org_bau.pxo j

New program files are
automatically opened in WinSPS
with a comment header that
displays project information.
Dependent on the file type,
WinSPS supplements the file
with additional text and program
entries.

The program call declaration is
entered in the editor

WinSPS immediately checks
any program entry. While the
cursor still points to the row,
WinSPS automatically formats
the program instruction if the
entry is free of errors.

At the beginning of the
command line WinSPS marks
errors and alerts with an
abbreviated error indication.
After the cursor is positioned on
the line, the status bar displays
information on each selected
line.

module that is called by OML.

The module call instruction is
declared in the IL.

The instruction "CM” cannot be
displayed in the FBD.

[org_bau.pxo dmmm R AR

Network No.: u I j ﬂﬂ

Company : llﬂ
Date: 08.

Author: Riedel
; Version: 1.0

FProgram module file

CH —PROGEAM1
EH

-

4 3

————————————————————

; Version: 1.0

> CM FCO ; Call of program module FCO
EM
S CHM —FROGEAN

Source operand unkhnow

Alerts have an informative
character and do not have to be
remedied. However, they can
indicate logical errors that might
cause serious disruptions of the
program cycle.

Save the Organi—
zation Module OM1
as “org_bau.pxo”

Save

19



Creating the program
module FCO

The second program module,
namely FCO, is called up by the
organization module OMI. It
contains the PLC program.

Multiple program blocks are
created for large projects to
allows separate programming
and testing of individual
functions in the PLC program.

A new FCO module must be
created. You can specify
"programl.pxo” as file name.

Creating and opening the file
Enter the new file name in the
file selection window and
confirm with Enter.

programi.pxo ~|

Expand the file selection window
and select the file.

[PrOGRAM1.PXOJIR
JORG_BAU.PXO .|

PROGRAMI1 .PX(L
PROGRAM2.PX® -

20

Splitting IL in networks

Split the program into networks.
You can then edit it in IL and in
FBD.

The network sequence
corresponds with the workflow
of the system. However, it can
also be selected differently.

¢ Switching to the network view
with "View -> Networks”

¢ Splitting the new IL program
into single networks

Separate the network

The instruction "EM” is moved
to a separate network because it
cannot be displayed in FBD.

All program instructions as from
the cursor position are moved to
a new network. The FBD
program is created in the first
network.

Changing the network
=] 2]

You can return to the previous
network with a click on the up
arrow button. As an alternative,
you can use the key shortcut
"Ctrl + PageUp”.

Changing the programming
language to FBD

IL FBD

WinSPS switches to the FBD
view only if the instruction
sequence in the expanded
network can be viewed in FBD.
Otherwise, the status bar displays
the message "Cannot display row
in FBD PI no.: 1”. "PI” points to
the first row of the program
instruction that cannot be
compiled.

The symbol window

The program editor lets you
change the size or completely
hide the symbol window by
moving the separating line
towards the input box via mouse
button. The symbol window
displays the symbolic names of
all operands in the edit box.
WinSPS continuously updates
the symbolic names.

A —traffic_light
A —key for deman
AN —marker_for_de
S —marker_ for_de
Al
0.0 traffic lights
I Io0.0 kev_for_demand
HO .0 mnarker_for_dem
MO.0 mnarker for dem




Networks Eﬂﬂ in FBD

The cursor must be positioned To split the networks in FBD, The new networks are inserted
on a new row you want to editin  call the network commands in above or below the current
the FBD input box. You can the menu "Edit -> Network network.

create and edit single blocks instructions”. A network toolbar

using the elements of the FBD is only available in IL.

toolbar.

FBD toolbar
AT & =1 =1 CPL. SB RS Tw. Ci.  JPx.CMa. =
Inserting a logical AND Inserting RS/SR elements
WinSPS creates Instead of SR, =" elements are
networks using the used in some networks.
3-: two elements "&” and Dependent on the logic result,

»n_»

this allows you to set or reset
outputs, markers and similar.

Inserting additional inputs Negating inputs
In order to add To negate an input, Inserting SR elements.
:Elvaj an input pin, the ﬂ ﬂ the cursor must be The cursor must
cursor must be positioned on the be positioned on the
positioned on it. input pin. 5 F: cross—link leading the
’=" element.

Naming I/0s Naming the network To insert further RS or SR
Insert a name in the network elements, position the cursor
row, for example, "Switch on the cross-link leading the ="
traffic lights to red”. or RS/SR element and insert the
Save the program. RS or SR element.

If you want to replace "=" with
an RS/SR element, insert the RS
or SR element and then delete

Declare the operand. The cursor the "=" element. Click on the "="
must be positioned in the name element and delete it with the
box of the pin. Hit enter to move "DEL” key.

to the next field.

& »=1 =1 CPL.. SR RS T=z. Cx. JPR CHx. =

Metwork No.: |1 ISwitch traffic lights to red j jﬂ

—traffic

—narker f —- } -

Network no. 1 program].pxo j :

21



Before you download the

program to the PLC

e Switch on the controller

e Connect the data link to the
PC and the controller.

m Change Help

Load ...
Unload ...

Chl+2slt+L

Bun
Stop
Cuakern cammandz

Load date/time

Download the PLC program to

the controller with all the

modules that you have entered
in the symbol file. Do not change
the default settings in the "Load”

window. Confirm your entries

with OK.

Prior to downloading and for
reasons of safety, WinSPS

switches the controller to "Stop”

mode and returns it to "Run”
mode after the download.

22

The red "Stop” LED on the front
panel of the controller is switched
off when the program is running

on the CL150.

Open the
Monitor to test

=

Monitor

The transferred PLC program is
tested in the Monitor.

WinSPS only starts the Monitor

if

e all PLC program modules are
error-free and downloaded to
the controller and

e if communication is established

to the switched on controller.

the PLC program.

Downloading the program to the controller

Do not test your program in a
unit that is currently occupied by
other tasks. The program might
switch outputs and as a result
create unexpected switching
states.



The Monitor

Program testing Find text Open the Editor
tools
Memory Bosch Anchor,
configuration cyclical access
Switch the tothe PLC —
program level Configuration|
Reference Select the
list programming
language

[Project: STEP1AVCL150] - PROGRAK1.PX0 - WinSPS Monitor - CL150 [Build 1323)

Menu bar —  File' Edit “iew Control Changk Help

) A [ ar © & @ E] B K —

Frog. Data Te:-:t Opergnd D-Field  Force Find Info  Diagram  Ligt E ditar LD FED

File selection — Iprugrampru j ? /_ Load .  Edt  |E Display .
Network — | Network No.: |1 ISwitch traffic lights to red j j ﬂ
display

. Author: Riedel Company: Hiedel j
Input box : Version: 1.0 Date: 08.01.2001

Frogram module file

AN —-marker_for_ demand " il |
= —traffic lights red 10 |
| _>|_I
. HO. 0 marker for demand
Symbol Q0.0 traffic lights red
window
Status bar — Li 1

WinSPS offers some

highperformance tools in

the Monitor which allow you

to

e test the program,

e monitor controller and
program states,

¢ monitor the I/0 image,

e retrieve module calls,

e and to switch I/O states.

Especially Operand and Fixing
Files are used to this purpose.
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Program module Monitor

View of the

Input bit
Logic link bit VKE
Output bit
Interrupt
[eitazcoNnz | A=
|
Register
Zero
Negativ
Overflow
Carry

FBD view of a network in the
Monitor. The displayed network
is cycled. The logical AND link
is set. Marker MO0.1 is set after a
10 s interval has expired.

Data Module Monitor

Displays the Data
%?)E Module and the
Data current controller
values.

Data Modules allow you to
access and modify controller
data, provided it is stored in

the controller RAM area. Data
Modules in the (E)EPROM area
are read-only

24

running PLC program

Iprogram1.pxo j Fl/_l
Network no. | 3 |

-

I0.3
00.4
MO.O
00.3

2 OH

g

You can shift the separating
line between the program and
monitor display per mouse.

In the IL view, the current
system status is displayed for
each program instruction.

You can customize the display
of register values and the
representation of variables via
the menu "View -> Format ...”.

Network no.: | 3 | Interval between a red/green transition of the crossove

T1
MO.0 005 =
M1.0

T#10s

_—
e AF | [T oo | &,
Prog. | Data Text | Operand D-Field| Force
I dat_bau.pxd vl

LEMNGTH=4 :

o TORD o 00000
2 TORD 5 0000S

DE 4 UINT 1640

DE & UINT 1680

DE & UINT 1680

DE 10 UINT 1640

DE 1z UINT 16#0|

DE 14 UINT 1680

The left-hand side displays the the right-hand side the current
content of the Data Module, controller data.



Operand field Editor

You can display
any operand
on-screen and edit,
mark or control it.

On the same screen you

can simultaneously display
miscellaneous operands which
cannot be displayed this way
in the IL Monitor.

When working with large PLC
projects, the operand field editor
offers a view of all important
operand states.

You can edit these operand
values and transfer them to
the controller.

Data Field Editor

The Data Field Editor

w displays entries in the
D_Feld retentive data field of
8192 bytes length.

You can edit, mark and then
transfer your entries to the
controller.

The button functions correspond
with those of the operand field
editors.

Data field entries must be
inserted in ascending address
order.

Prog. | Data

Fie J
Text  JOperand D-Field| Force

&

Find

Diagram List

=/}

Editor

0

Info

ontrol |

I dat_bau.pxd j ./ Edit In Display % % Flag

DEO[0]

UINT 5159

EO USINT Z#00011000

a0 TUSINT 2#DDDD_DDDD

Mio WORD

=0 Editing the

./ Edi | operand field

and declaring
new values.
Display of

n Display |

operand values
with cyclical
update.

Entries marked "Fixed” are
the ones you have modified in

"Fixing Editor”, the Monitor tool.

u]

Z#11000
200001001
ooooo

Marking
=1Flag | operands with
changed
initialization
values.

Modified operands must
be marked before they are
transferred to the controller.
Marked
(M Control | o d
perands are
transferred to
the controller
with their new
initialization
values.

ovTE | A | T

Prog. | Data
| dfeld.dxd

Text |Operang D-Field _Force

0

Info

By

Diagram List

=}

Find Editor

j " Edit In Display %% Flag

Control |

LENGTH=10 »

u} TINT 2#1100100010001000 Z#0
5 BOOL u} FLLZE
] BEYTTE 255 aoo
=] TINT 16#0 16#0
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The individual program
modules and the complete PLC
program are tested prior their
execution. This is carried out by
connecting the inputs to the
PLC via a simulation field with
diverse switches, or by
simulating the connection

using the Fixing Editor, the
Monitor tool.

Testing the

Fixing
You can fix inputs, outputs and markers.
Fixing overrides externally switched I/O states.

Fixed inputs are not displayed on the LED bar of the module,
outputs, however, are shown.

Fixing is cancelled if you load a fixing without entries.
Data input in the fixing editor is:

Operand Data typ Fixing a value ; Comment
I0.3 BOOL 1 ; set I0.3 to ”"1”
I USINT 2HXXXXXKXIX ; fix I0.1

controller program

The "Traffic light” example is
tested with the fixing tool.

WinSPS opens the

@’ fixing file force.txd”
Force when it starts the
Fixing Editor.

Two additional buttons are
displayed above the working

area:

Load the fixing

- JinfezEe | configuration to

the PLC.

ﬂ Load Unload all
fixed I/O

signals to the
Fixing Editor.

Accelerate the load rate after
minor program modifications.

Transfer the opened
f file from the editor to
the PLC. Open the
Monitor view.

Lo—>Mo
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Inputs 10.0 to 10.6 are modified All bits which are not fixed can

in the PLC program; 10.7 is be masked with an "x” rather
not used. than ”0” or "1”.

I0 USINT 2#x0000000 ; reset I0.0 to I0.6

The CL150 reactions can be Do not close the first WinSPS
monitored via the output LEDs.  window and open WinSPS once
again via Windows Start menu.
The program monitor displays Open the monitor directly in
detailed information on all the configuration of the second
program states. WinSPS window. Open all files

in read-only mode.
You can open a second WinSPS

window to simultaneously fix Both WinSPS programs run
inputs and monitor program parallel and update data using
changes. the same data link. Therefore

you can monitor program
reactions parallel to the Fixing
Monitor.

Debugging programming errors

i Correct the errors f

Editor Lo—>Mo




Documentation is an essential
part of programming work. The
programmer will only be able to
systematically debug errors or
continue to edit a program if the
program is well documented.

WinSPS offers a series of
functions and a Help for PLC
program documentation, ranging
from the creation of the new
module to printing out the
finished PLC program.

The print function allows you to

¢ output program modules in IL,
LD, SFC and FBD with and
without comment texts,

e display programs with
symbolic or absolute operands,

e output cross-reference lists,
symbol files, network and
module overviews.

Print jobs can be output to a file
in order to make them available
for further use in a text editor.

The stack processing function
simplifies documentation tasks
for large projects. The print
objects are displayed in a
window and released for
printing in one pass.

The programmer takes care
of the major part of the
documentation while he is
programming. This includes:

e structuring the PLC program,

e commenting the program
steps, networks and modules
in IL,

e using symbolic programming.

WinSPS joins the comments in
the PLC programs to form a
complete documentation.

Print program module

- Module
™ cument program module

% from symbal file

Commenting the FBD program

Program commenting is only
possible in IL.

FBD only displays the comments
above the network layer.

When a network is generated
from IL to FBD, there must be
no comment lines inserted
between IL instructions.

Documenting the PLC program

— Representation
7 |nstuction List [IL]
™ Ladder Diagrar [LD)

™ from batch file Istapel.stp vl ¥ Function Block Diagram [FED)
Sefup .. | — Lapaut
Pt il [~ Output BG number
rint ihe [©| Operands symbolic
¥ Filename: IIist.th 'I v with line comment
— Metwarks — Symbal cormmet

[ with network overview
W with network title
™ one network per page

— Parameter list
W with parameter ligt

[ with symbol comment
™ Surnbollcomm, atendiof page/iy
= | Sumb. comment Byte/wond addr. OH

Symbol length for print

yDK

x Cancel |

D v |

You can customize the content
of a standard print header and
the print layout via diverse
settings in the editor menu "File
print layout...”.
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7
Qnary links — e
AND

A
I, O, M,
AND NOT AN Bit d,iiP T,C,R,P
OR o Status bits
OR NOT ON
Set S
Reset R Bit d,i,P O,MR,P ﬁ
Equal =
EE ]
Time commands ——— ——— P
Pulse SP ] )B : i
extended Pulse SPE “Bracket instructions
On—delay SR dP RTP AND bracket open (
Rise—time OR bracket open O(
On—delay SRE Close bracket )
Off-delay SF Negation of the bracket content )N
Reset time RT
dP TP
Timer Stop TH
YDigital links PR c—
AND A
- AND NOT AN
,//
Mmter instructions e — OR 0 W,B d,iiP KR
OR NOT ON
Counter up cu EXCL. OR NOT XON
Counter down CD dP C,P
Reset counter RCY
-— D
=05
- Compare commands s —
. . Compare CPLA W,B d K, R
Data transfer instructions — —
Load L D,W, d,i,P I,O,M,T,
B C, K R,
El, D, DF,
P, S
Transfer T W,B d,i,P O, M,IO,
EO

28



of CL150

ommands

0

Conversion instructions —
Binary — Decimal BID
Decimal—>- Binary DEB

w,B d

Two’s complement TC
Negation N

Byte exchange = SWAP w d

—_
Null operations, carry manipulations
Null operations ”0” NOPO
Null operations ”1” NOP1
CARRY-BIT "1” SCY
CARRY-BIT "0” RCY
Q2 A
Rotate and shift instructions —
Rotate right ROR

Rotate left ROL
Rotate right with CARRY RCR
Rotate left with CARRY RCL

Logical SHIFT right SLR
Logical SHIFT left SLL
Arithmetic SHIFT right SAR

Data types Adressing Operands
N

D
Bit Bit d direct O  Output
B Byte i indirect EO Extended Output
W Word P Parameter D Data word
D Double word DF Data field

| Input

El Extended Input

== Arithmetic operations e

Addition ADD

Addition with carry ADC

Subtract!on . SUB W.B d
Subtraction with carry SBB

MultipliCation MUL

Division DIV

I t INC

ncremen W.B d

rogram stop/end

Hold command  HLT
Program end EP

'Calling blocks

absolute

conditional
with VKE=1

ilnterrupt commands s

Enable Interrupt EAI
Disable Interrupt DAI d
Reset Interrupt  RAl

CM

CMC

ﬁEnd of block instructions

absolute
conditional
with VKE=1
LYy O
Jump instructions
R absolute JP
conditional JPx

P Parameter

IO Interface Output R Register

Il Interface Input S System area
K Constant T Timer

M Marker C Counter

EM

EMC
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Binary instructions are the basic
elements for logical links.

A binary command consists of
the operation and the operand.

Binary Operations

Logical AND

A Query for signal “1“
AN Query for signal “0"
Logical OR

O Query for signal “1*
ON Query for signal “0"

Assignment statements

= Assign logical
link result

S Output, marker...
set signal to “1

R Output, marker...

reset signal to “0“

Logical links

You can program logical links
in IL, FBD and LD. For FBD
and LD presentation you must
work in networks.

A network for binary links
consists of a logical AND/OR
sequence. It starts with an AND
instruction or with an open
bracket ”(” and ends with the
assignment of the logical link
result (RES).

IL

A 101 ;AND 101

AN 10.2 ;AND NOT 10.2
(0] M1.2 ;ORM1.2

= 01.3 iRSEin O1.3

30

Logic & more

Operation Operand <; Comment>

A I0.1 ; Logic AND with I0.1

S 01.2 ; Set Output 01.2

= M1.2 ; Pass RES in marker

Operands Operands and valid address
area

ID, input here Inputs 10.0 to 123.7
Byte address
| BitID, I/O Outputs 00.0 to O15.7
||

I 0.2 Markers MO0.0 to M191.7

C 3
| Timers TO to T127
Counter ID

ID, counter here Counters CO0 to C63

s Comment

==

(* Comment *)

Comments begin with a semicolon; or they are enclosed with

(* and *).

Comments can only be edited in IL.

In FBD and LD, WinSPS
displays each network
individually. In IL you can
also work with a list view of
all networks and completely
without network technology.

FBD LD

o1 01 102 013
1 & —N—
0.2 g — >=1 M1.2

—0O1.3




(Bracket functions)

Links are evaluated strictly in
accordance with the rules of
Boolean logic, that is, "AND

has priority over OR logic
operations”. You can use the
bracket functions and markers to
change the evaluation sequence.

AND has priority to OR

; Network 1

AN 10.0

A I0.1

0 I1.2

A I1.3

= 00.1

I0.0 —g
&

I0.1 —

I1.2 — >=]
&

I1.3 — — 00.1

neling

WinSPS operates with absolute
and symbolic operands.
Absolute operands are called
via their address, for example,
10.0.

Symbolic operands are addressed
with their symbolic name. The
name should describe the
operand’s function to make the
program more comprehensive
and easier to read.

( AND bracket open

O(  OR bracket open

) Close bracket

)N Negation of the
bracket content

Brackets
; Network 2
AN I0.0
(
A I0.1
(6] I1.2
)
A I1.3
e 00.1

I10.0—0

&

I0.1— —

5=l
I1.2

I1.3— — 00.1
I0.0 I0. I1.3 00.1

NNl

Absolute or symbolic

— Symbolic name

Declaration in the symbol file

Writing method ”- Symbol name”

Case sensitive

Bracket function can be nested in
seven levels.

A network with bracket function
can also be represented with
markers.

Not allowed are mutated vowels and special characters

The symbolic name of the module corresponds with its name in

the module file.

Length of symbolic names
— for modules maximum 8 characters
— for other operands 32 characters

Operand Task absolute

10.1 Input I0.1 reports slide at the front AN I0.1

00.3 Starts the conveyor belt = 00.3

DMO Module file "crane_dat.pxd” with data for the CM DBO
project "CRANE"

C3 Parts counter L W Z3,A

D4 Maximum buffer capacity L W D4,B

symbolic
AN -Slide is Forward
= -Belt_On

CM -CRANE_DAT

L W -Number_of Parts,A

L W -Max_ Number of Parts,B
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Counters

The CL150 offers 64 counters
and 128 timers. They can be
started via program controls
and without additional hard-
ware.

You can program counters and
timers in IL, FBD and LD.

Programming counters

Counter operands are C0 to
C63.

Count starts at the rising edge
of RES.

The count starts at O or at the
declared start value.

Valid count area and start
values are 0 to 8191.

Up-counter CU

; Count
A I0.4 ; If I0.4 toggles O
CU C1 ; increment Cl by 1
; Set counter to 1
A MO.5 ; If MO0.5 is set
L W 1,A ; load counter status 1
SCY A, Cl ; Set counter
L W Cl, A ; Load counter wvalue
; Reset counter
A I0.0 ; If I0.0 toggles O
RCY C1l ; reset counter
; Save counter value
L W Cl, A ; Load counter wvalue
T A, M4 ; Save counter value
; Query counter wvalue 0
L W Cl, A ; Load counter wvalue
A C1l ; As long as counter is
not O,
= M1.0 ; Merker M1.0 setzen

32

Generating timers and counters in FBD

WinSPS automatically generates FBD modules for counters
and timers. When you subsequently switch to IL, the result is a
determined instruction sequence for the IL view.

If you toggle between IL and FBD you must not modify the
instruction sequence determined in IL via FBD.

Counter commands

SCY
CuU
CD
RCY

The counter status is queried using the load command ”L”.

Up—counter

Co

Declare the counter start value
Increment
Decrement
Reset counter to 0

CU
cu
PV

LD CV

R

Q

->

->

Down—counter

Cco

CD
—{CD
— PV
—LD CV|—

CU/CD:Count condition

PV: Start value

LD: Load condition for
start wvalue

R: Reset condition

CV: actual counter wvalue

Q: Counter = 0: RES = 0
Counter > 0: RES = 1

CU/CD and Q must be
wired.

C1
(e48)
I10.4—CU
— PV
— LD CV
I0.0—R Q




Times

Programming times

Times start at the pulse edge of
RES

e SP, SPE, SR and SRE at the
positive edge
o SF at the negative edge
Transitions within the st cycle
after a program start are
ignored. The time period is
declared in the time constant.
Times are actualized in the I/0
cycle. During a program cycle
the time end is therefore not
recognized until the next cycle.

S

Time commands

SP  Pulse time start

SPE  Start Pulse Extended

SR Start Rising Edge Delay

SRE Time start as rise-time On-Delay
SF  Start Falling Edge delay

RT  Reset time with RES=1
TH Time Hold with RES =1

The current time is queried using the load command ”L”.

Time constant: T#10ms to T#10230s

IN: Start condition

Time diagrams

SP Start Pulse Time

SPE Start Pulse
Extended

SR Start On-Delay

SF Time start as
Off-delay

SRE Time start as
Rise-time
On-delay

T0 PT: Time constant
SF ST: Hold condition for
—|In ET}|— time o
PT R: Reset condition
or ET: ExXtra time
Q: Time status

IN, PT and Q must be
wired.

Start condition | | Bl
Reset condition — — ‘
Time status

Start condition _| L_ _I___I_I_I_]__
Reset condition J—I—

Time status

Start condition _} L o 11

Reset condition
Time status |

Start condition _] |

Reset condition !
Time status

Start condition —] L—]w

Reset condition ‘

Time status i —I——‘——l_——-—r—l
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E (]

Time start as pulse SP

A 10.2 ; I10.2 from 0->1
L W T#2s,A ; Load time
SP A, T2 ; Start time T2
A MO.O ; MO.0 from 0->1
TH T2 ; Hold time counter
L W T2,A ; Load time wvalue
T W A,DF4 ; Transfer to DF4
L W T2, A ; Load time wvalue
A T2 ; Time running?
= 02.1 ; Set output

T2

SP

I0.2 — IN ET|— DF4
TH#2s — PT
M0.0 — ST

e e

02 — =
M0.0 L
19 — LT L

IR -]
PN

<>
ti+te=t

=« I

OO OO
o
e Yafafalafale afalefalanfain fl ofere
[@ EDDDDDD%DDDDDDEADDD
©

I

e
0000000000000 |00

Start Time as On-delay SR

A I0.6 ; I10.6 briefly from 0->1
L W T#5s,A ; Delay 5 sec

SRE A,T1 ; On delay

A I1.0 ; I1.0 from 0 -> 1

RT T1 ; Time off

L W T1,A ; Load timer wvalue

A T1 ; Time running Tl= 0

= MO.3 ; Time expired:

; Tl= M0.3 =1

T1
SRE
I0.6 — IN ET|—
T#5s — PT
—1ST
to—n o { = Fwos

10.6

11.0

5s }
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Calculations

The CL150 offers digital linking,
arithmetic function and compare
instructions for calculations and
comparison. Input data are
passed as constants or register
values. After command
execution, the result appears in
the register of the 2nd operand.

The status bits display supplemen-
tary information regarding the
result, for example, the prefix
operator or calculation errors.
Zero, the result is zero
Negation, negative result
Carry, carry bit

Overflow, range overflow,
division by 0 or result value
exceeds 16 bits.

OO0 ZN

Registers are used as
intermediate memory for data
exchange. The CL150 operates
with the four 16-bit registers A,
B, C and D.

Calculating operations cannot
be displayed graphically. They
can only be programmed in IL.

Compare =?

The CPLA instruction can be
used for logical and arithmetic
comparison. It can be
programmed in IL or FBD.
The compare result is evaluated
via status bits.

LS00
APYA
Operation 1st Operand 2nd Operand
Digital linking A, AN, Constant Register
O, ON, registers
X0, XON
Arithmetic ADD, ADC, Constant Register
operations SUB, SBB, registers
MUL, DIV
Compare function CPLA Constant Register
registers
AN B A,B
ADD w 14,A
| | 2nd operand, register
| Ist operand, constant or register
Byte- length or Word length

The addressing instructions ”L” Calculate 25 - 10 =15

and ”T” are used to exchange the Load”

values, for example, of a counter ’

or data field, between the L W 25 A A |s=— 25

registers and an operand of the Y

CL150. Lwi1oB) Ble—10
C

The load operation "L” loads the D

register with a constant or with
the value of an address area.

The transfer operation ”T” returns
the contents of the register to an
address area.

Calculate = «— 25-10
SUB B, A 115 —> A

Return value “transfer"’

T W ADFo| A ]—e DFO
 p—

IL instructions in FBD

When programming in FBD, a separate network must be created
for every instruction sequence that cannot be displayed in FBD.
WinSPS automatically toggles the display mode from FBD to IL
if a network cannot be displayed in FBD.

Counter setpoint 30 reached? Evaluation of the logical
comparison

L W Cl,A ; Counter value

L W 30,B ; Setpoint 30  CPLA W B,A  Query

CPLA W B,A ; Compare A=B A 4

AN cY ; A >= B? A=«B AN 2

= 00.2 ; RES -> 00.2 A<B 2 oy

A<B A Z
30 — IN1 o v
>=

A>B AN CY

Cc1 — IN2 Q_E'_OO'2 AN 7

A=B AN CY
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Calculation with Byte or Word operands

Byte operands can occupy any
operand address, I3, M91, O5.
Word operands must occupy
even-numbered address areas

only, O14, M0, I6.

With add and subtract operations,
the input and result operands
occupy the same register length.

Multiplication with Byte and Word operands

10*20=200 '

LB 10,A A|<—10

LB 20,B |B|s—20
Ci

MUL B BA ;200> A

TB A MO IAI—éMo
=

MO =200

M

[NESNEENENNNEEENN)

o)
|  |[pooooooopoooooog
[ il el
©

nnnnnnnnnnnnn

I

The results of multiplication
instructions and the division
operation for the first operand
require double register length.

200 * 350 = 70000

L W 200,A | A |e— 200

L W 350, B B|<— 350
Ci

MUL W B,A ;70000 ->BA

BA=Bx2/6+A ’

T W A, MO

A|l—> Mo

T W B, M2 Bl—e M2
MO = 4464, M2=1

Division with Byte and Word operands

112/10 = 11 Rest 2 ,

LW 112,A| A|<— 112
LB 10,B |£]<—10
]

DIV B BA ;2->Al, 11 ->Ar

TWA,MOl A|—> Mo
d"

MO =2x28+ 11 =523

Al: Register A left byte = remainder
Ar: Register A right byte = result

905/10 =90 Rest 5

L W 905,A A
0,B
10, C

LW
LW

<— 905
<0

B
C|<— 10
[

——

DIV W CA ;90->A,5->B

T W A MO
T W B, M2

Al—é MO

B|—> M2

—_—

MO =90, M2=5

36




———
E [{

== I

Indirect addressing of operands

With indirect addressing the
operand name and address are
declared separately. The operand
address is first loaded via register.

Bit operands such as 16.2 are
addressed via Byte address and
Bit number.

Indirect addressing is used, for
example, to copy inputs to a
marker area using only few
commands. The Words of
inputs 110 to 120 are copied to
the marker words M50 to M60.

The ”JPx continue” command
means: jump to program address,
“continue” if the previous value
is not negative. The operations
INC and DEC add/subtract the
value of the 2nd operand
to/from the 1st operand.

OO
(el et l et |
D0 D00000p000000g A
Poonoooopoonoong|onog) | ——
00 D0000opooonoogooog)

of=mo

Addressing M2 directly Addressing M2 indirectly

L W M2, B

L W 2,A
L W MI[A],B

L W 50,A ;
A E[A] i

L W 5,A
L W 10,B
L W 50,C

continue:
L W E[B],D
T D,M[C]

INC B,2
DEC A,l
JPN continue

W
INC W C,2
W
W

50:8=6, Rest 2
Input I6.2

; Loop counter 5

; Start address for inputs: 10
; Start address for markers: 50
; Destination address for loop
; Read input value

; Write to marker area

; Next marker address

; Next input address

; Loop counter -1

; Loop counter >=0? => continue
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Constants, variables and address areas

Constants

Meaning

Representation Area

—
1
I

[fereaaefesereaiaafs Y eer |

EDDDDDDEDDDDDDDE .
uuuuuu
\poooooopooonoog oot

78900, -123000, 16#FEFAFEF5

Unsigned integer Binary 240000000000000000 to 2#1111111111111111
Decimal 0 to 65535
Hexadecimal 16#0000 to 16#FFFF
Signed integer Decimal -32768 to +32767
Text ASCII ‘ABC’
Time value T#10ms to T#10230s
alternative input:
T#0.r to T#1023.r,
r: 0=1ms, 1=100ms, 2=1s, 3=10s
Variable types
Meaning Prefix  Data typs Data length Examples
Bit X BOOL 1 bit TRUE, 0
Byte B BYTE, SINT, USINT 8 bit 232, -126, 2400001111
Word W WORD, INT, USINT 16 bit 12670, -2504, 8%376376
Douple word D DWORD, DINT, UDINT 32 bit
Counters CVALUE 16 bit 3
Timers TVALUE 16 bit T#10s
Strings STRING(x), OSTRING(x), variable with

VSTRING(x)

Address area of the load and transfer instruction
Transfer instruction “T*

T W Register, 2nd operand

Load instruction “L
L W 1st Operand, register

1. Operand Address area
Input, 10 to 147
Interface input II0  to IIl
Output 00 to O31
Marker MO to M151
Timers, TO  to T127
Time value 10 ms to10230s
Counters, CO to C63
Counter value 0 to 8191
Constant 0 to 65535
Register A,B,C,D
Parameter PO to P31
System SO to S255
Data Field DFO0 to DF8191
Bytes in Data DO  to D511

Module

2. Operand

Output,
Interface Outp.

Marker
System area

Parameter
Data Field

Bytes in Data
Module

length x

Address area

O0 to O31
100.0 to 100.7
MO to M151
SO to S255
PO to P31

DFO to DF8191

DO  to D511

"CHARACTER', 09, 3F, 0D,21, 3F, 7E
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Modules and files of the PLC program

The controlling and structuring controlling projects is assisted by
of PLC programs, as well as a the use of organization/program/
well arranged design of large data modules.

System Program ‘

om1

Y0 cycle

— ]

= Y Feo
5
Fc5

Organization Modules Program modules Data modules

OM1 to OM19 represent the FCO to FC127 contain the major ~ DMO to DM127 store the fixed

interface between the program parts of the PLC program. FC and variable values of as well as

and the controller. represents a Function Call. the text information in the PLC

Organization Modules Program modules program. Two DMs can be active

e start the PLC program e can call data modules and concurrently in a program block.
cyclically, other FCs, Data modules

e initialize the system area of e contain mainly interrelated e are called by FCs or OMs,
the CL150, functions of program parts, e contain between 1 and 512

e offer a variable program start; e can be called with I/O bytes of data per DM,

e process error and interrupt parameters, ¢ must be activated prior to
handlers and they e are closed with a "EP” using them,

e are closed with a ”EP” instruction. e are only active in the calling
instruction. FC or OM,

e stay active in the FC or OM
until other data modules are
called.

Data field

The CL150 manages a data
field with a size of 8 KB:
DF0-DF8191; can be used as
read/write buffer for any data.
The data field can be battery
buffered against power failure.
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The CL150 Organization Modules

Cyclical block
om1

B

The system cyclically calls the
Organization Module OM1.

The 170 image of the CL150 is
updated prior to each call. OM1
is used mainly for program
controlling. It starts the lower
program module level.

OM1 must be implemented once
in every PLC program.

All other Organization Modules
are optional.

Definition module
om2

LUQ

In OM2 you can edit system
configurations of the CL150 such
as, for example, the maximum
cycle time, time and timer
behavior or remanence limits.

At the first start of the PLC
program, OM2 writes the
Initialization to the CL150
system memory.

Configuration Table
om3

it

The configuration program
WinSPS creates an OM3 when
170 modules of the B~IO system
are manually configured.
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Startup Module
oM5

>

The OM5 program is processed
after the CL150 is switched on
and at the start of the PLC

program.

Startup Module
om7

BM

Contrary to OM5, the OM7
program is executed only on
transitions from Stop to Run
mode.

Error Module

In case of control program error
the OMY program is executed
before the controller changes to
Stop mode. This action, for
example, recovers important data
from remanent marker areas.

Interrupt Module
oM10- oM12

_\I/_

Programmed Interrupt Modules
are called by the system program
if the signal changes on specified
interrupt inputs.

Time controlled modules
OM18,0M19

Q

Time controlled modules are
called when a specified time
interval has expired and a
running program block is
terminated.

Time intervals can be edited in
the PLC program.
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Program cycle

Program structure

Start sequence and program
cycle with Organization
J‘L Module calls.

(F' OMz2 present? \ﬂ
yes

I I

L _— J)
1
Connected
B~10 modules = no :>

ok?

yes yes

i) i)

Power On? RUN/STOP
Start OM5 Start OM7

— J

e I/0 image

l
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Programming with

WinSPS

Using the CL150 to control
crossover lights

In basic state the crossover lights
should display red. The signal
should toggle to green

10 seconds after a pedestrian
who wishes to cross the road has
actuated the request button. The
pedestrian has 15 seconds to
cross the road; after that time
the signal toggles to red again.

In the following chapter we will
develop a control program that
meets these demands. You can
find helpful information on
handling WinSPS in the Chapter
”The Program WinSPS”.

42

@ [[ecoo;
| XX

ce

LTI T

[O000000po00000g
10000000poooooog

To00000poooooo|
0oooooopoooooog

[m)
0

0

EEEE
000

CL150
Basic equipment:

CL150 with 8 digital inputs
and 8 digital outputs



Programming the crossover light controls

Default configuration
Open WinSPS and customize
your default settings.

Project path: Metwork, W
IE:\F’HDGH.&M FILESSBOSCHWWINSF J

Library path:
|E:\F‘rogram Files\BozchyWwinSPS

| Mew project ... | Froject;

Contraller name: IEL'I a0 Contraller twpe

Program medule: — |PROGRAM1PAD 7]

Data module: ID.-'l'-.T_B.-’-'-.LI.F‘XD j

Symbol file: [PROJECT S%S =]

You can choose the names freely.
However, it is important that you
subsequently enter the correct
names in the symbol file.

After having completed your
default customization, call the
editor.

IT r- lights
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Call the editor

Customizing the symbol file

_ Open the symbol
# file and enter
Symbol the following:
In the row
| OM1,R ORG_BAU | (Name of your Program Module)
In the row
| FCO,R PROGRAM1| (Here you can name your
second Program Module)
In the row
| DMO, R DAT BAU | (Name of your Data Module)

Declare all other operands
below. You can freely choose I0.0 Request button

the sequence.
00.0 Crossover_ lights red

You should initially plan your 00.1 Crossover_lights green
I/0 and marker assignments
and enter them in the symbol
file. You can modify them at

MO.0 Request Marker
MO.1 Time Marker 1 Crossover red green
M0.2 Time Marker 2 Crossover green red

any time.

M1.0 Step marker 1
An alert in the editor’s status M2.0 Step marker 2
bar will warn you if you are
using programming elements T1 Time_ red green
that you have not yet entered T2 Time_green_red

in the symbol file. This alert is

cleared after you have updated
the symbol file.

Programming the

Organization Module OM1

The Organization Module OM1
is displayed by default when you
open the editor.

If this is not the case, select the
file ”Org_Mod.pxo” in the file

selection window.
Call the program module FCO
with the help of OM1. Insert the

CM row for the module call
above the EM row.

CM FCO ; Creating the program module FCO

Save the file.
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Creating the
program module FCO

Create this program module and
name it "program1.pxo”.

Switch to the FBD view and
enter the program networks.

1 Set crossover signal to red

2 Evaluate the request button

* 7

o
O

'

3 Time delay Red -> Green

/'\\
N/
/'\
g

4 Switch crossover signal to green

QO

Ol
()

5 Time delay Green -> Red

;i

19
~
Y

6 Switch crossover signal to red

mOO

7 Module end
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The Program Module
"programi.pxo”

AN
S

e

SRE

e

nHdn"D-p P

Network 1, Set crossover signal to red

MO0.0 ; Request Marker off 00.0
00.0 ; Crossing signal red MO. 0 & s1
. . 0
Network 2, Evaluate the request button
00.0 ;Crossing signal is red and
I0.0 ;Request button actuated and 00.0 — &
MO0.0 ;jRequest Marker not set 10.0 — M0.0
MO.0 ;Set request Marker MO.0 s1
M1.0 ;Step Marker 1 R 0
M1.0
s1
R Q
Network 3, Time delay Red -> Green
MO0.0 ;Request Marker is set Tl
M1.0 ;and Step Marker 1 is set MO . 0 — &
T#10s,A ;10 seconds M1.0 SRE
A,T1 ;Rise-time delay — IN ET
T1,A ;Load timer
T1 ;Timer running? T#10s — ::
MO.1 ;First time Marker is set R
; if T1=0 Q —M0.1
Network 4, Switch crossover signal to green
MO.1 ;First Time Marker is set
M1.0 ;and Step Marker 1 is set MO.1 —of &
M1.0 ;Reset step Marker 1 M1.0 M1.0
00.0 ;Pedestrian red signal off R1
00.1 ;Pedestrian crossing lights green s 0
MO.1 ;Reset first Time Marker
M2.0 ;Step Marker 2 is set 00.0
R1
S 0
00.1
s1
R Q
MO.1
R1
S 0
M2.0
s1
R Q
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Network 5, Time delay Green -> Red

A 00.1 ;Pedestrian crossing lights T2
sgreen?
M2.0 ;Step Marker 2 is set 00.1— & SRE
L W T#15s,A ;15 seconds green M2.0 | 1N  ET
;for pedestrians
SRE A, T2 ;Rise-time delay T#15s — PT
L W T2,A ;Load timer ST
A T2 ;Timer is running R Q— = —MO0.2
= MO.2 ;Second time Marker is set
;if T2=1
Network 6, Switch crossover signal to red
A MO.2 sSecond time Marker is set
A M2.0 ;and step Marker 2 is set MO.2 — &
R M2.0 ;Reset step Marker 2 M2.0 M2.0
R MO.0 ;Reset Request Marker R1
R 00.1 ;Pedestrian crossing green signal off s 0
R MO.2 sReset second time Marker
M0.0
R1
S 0
00.1
R1
R Q
M0.2
R1
S 0
Network 7, Module end
EM EM

Download the program to the
controller

Switch on the controller. Ensure
that the operation switch of the
CL150 is in "Run” position.

To transfer the program to the
controller, select "Load” in the
menu ”Controller”. Do not make
any changes in the "Load”
window. Confirm your entries

with OK.

The program is compiled during
this loading process. You will be
warned of any errors in the
program syntax.
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Open the Monitor view

After you have successfully
transferred your program to the
controller, output O0.0 should
light up after you have switched
the controller to RUN mode.
This output represents the red
signal of the crossover lights.

&

The rotating Bosch Anchor in the
upper right of the Monitor dialog
box indicates that the controller
is running.

Now call the
Monitor.

Testing the control program
You have two program testing
options:

Simulate the request key by
connecting a switch to input
00.0 of the controller or via
Fixing function.

You only need to actuate this
corresponding switch to monitor
the program reaction in the
Monitor view.

@ Call Fixing.

Force

To restart the cycle, you must set
and reset input 00.0. If O0.0
stays set the process enters a
kind of endless loop.

Fixing
Step  Simulation of Inputs Fixing Outputs
on off ”Load” on off

0 Traffic signal red 00.0
1 Actuate the 10.0

request button 10.0 BOOL 1 00.0
2 Release the i0.0

request button 10.0 BOOL 0 00.0

The additional program steps

proceed without user intervention.

Explanation

Red light is lit
at program start

Request button is
actuated

Request button is
released
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Programming the counter

In a second step the existing
program will be extended:

The counter is to determine how
often the request button has been
actuated within the 10 seconds
until the crossover light toggles
to green signal. If a crossover
light change has been requested
five times or more, the green
phase will subsequently be
extended from 15 seconds to

30 seconds.

Open the Explorer. In your
program path (C:\BOSCH\
Tr-lights, if you have adhered
to the default specified above),
create a new subdirectory
”STEP2” at the same level as
”STEP1”. Then, copy the
STEP1 subdirectories to the
new directory. The first program
section is now available for
editing your expansion in

STEP2.

Click on Project Name in the
WinSPS default configuration.
The box below should now
display the STEP1 and STEP2
fields. Click on STEP2 and open
the editor.

First again, customize the symbol
file.

You do not need to edit the
Organization Module OM1.

IO.

00.
00.

MO.
MO.
MO.

MO .
MO .
MO .
MO .
MO .

M1.
M2.

T1
T2
T3

Cl

N =

N oUW

o

Request button

Crossover_ lights red
Crossover lights green

Request marker
Time Marker 1 Crossover_ red green
Time Marker 2 Crossover green red

Counter_ Marker

Time meas 2 cross_green red Counter 0
Marker to set Counter

Marker for T2

Marker for T3

Step marker 1
Step marker 2

Time red green
Time green red

Time green red Counter not 0

Request Counter
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New Network

Now, open the program module
FCO you have named
”programl.pxo” and enter your
changes.

Here, you must recreate the
networks displayed in black
color, or modify them if they
already exist. The new program
parts to be changed are high-
lighted in the source code below.

- ‘ 1 Set crossover signal to red
O

—
g 2 Evaluate the request button

—»—DC.D 3 Time delay Red -> Green

T / 4 Set counter and decrement

8 5 Switch crossover signal to green

O—»—D. 6 Time delay Green -> Red
7 Determine the T2 Marker

8 Time delay Red -> Green, if counter = 0

10 Switch crossover signal to red

m 9 Determine the T3 Marker
@
@)

11 Module end




»

n unn

i

e

.0 ; Request Marker off
.0 ; Crossing signal red

;Pedestrian crossing signal is red and
;Request button actuated and

;jRequest Marker not set

;Set request Marker

;Step Marker 1

;Marker is set

o oo oo

00.0

s1

MO.0

sl

M1.0

s1

MO0.5

sl

MO.0 ;jRequest Marker is set
M1.0 ;and Step Marker 1 is set MO . 0 —
T#10s,A ;10 seconds M1 .0 —
A,T1 ;Rise-time delay
T1,A ;Load timer
;Timer running?
.1 ;First time Marker is set
;if T1=0
Network 4, Set counter and decrement
.0 ;Pedestrian crossing lights red
00.0 ;Request button actuated 00.0 —
jCounter = Counter - 1 10.0—
MO.5 ;Marker is set
4,A ;Load counter status 4
A,Cl ;Set counter
Cl,A ;sTransfer counter to A

;Counter 1 not 0 | Counter 1 = 0

MO.3 ;MO.3 =1 | M0O.3 =0

—MO.1

— MO0.3




A MO.1 ;First time Marker is set
A M1.0 ;and Step Marker 1 is set MO.1 — & M1.0
R M1.0 ;jReset step Marker 1 M1.0 —o ‘
R 00.0 ;Pedestrian red signal off R1
R MO.5 ;Reset set Marker S 0
S 00.1 ;Pedestrian crossing lights green
R MO.1 ;Reset first time Marker 00.0
S M2.0 ;Step Marker 2 is set
R1
S Q
MO.5
R1
S Q
00.1
S1
R Q
MO.1
R1
S Q
M2.0
S1
R Q
A 00.1 jPedestrian crossing lights green? T2
A M2.0 ;Step Marker 2 is set 00.1—I & SRE
A M0.3 ;jCounter Marker is set M2. 0 —
L W T#15s,A ;15 seconds green MO. 3 — IN ET
;for pedestrians PT
SRE A, T2 ;Rise-time delay T#15s — ST
L W T2,A ;Load timer
. . . R Q —MO0.2
A T2 ;jTimer 1s running - N
= MO.2 ;Second time Marker is set
;if T2=0
Network 7, Determine the T2 Marker
AN T2 ;If the timer is running, T2 = 0 MO.6
S MO.6 ;MO.6 1is set 2.0 & s1
R Q
Network 8, Time delay Red -> Green, if counter = 0
A 00.1 ;Pedestrian crossing lights green? T3
A M2.0 ;Step Marker 2 is set 00.1— & SRE
A M0.3 jCounter Marker is set M2 .0 —
L W T#30s,A ;30 seconds green MO .3 —] — IN ET
; for pedestrians
’
SRE A,T3 ;Rise-time delay T#30s — :g
L W T3,A ;Load timer
: : : R Q — MO . 4
A T3 ;Timer is running .
= MO.4 ;Second time Marker is set
;if T3=0
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Network 9, Determine the T3 Marker

T3 ;When the timer is running, T2 = 0 MO0.7
MO.7 ;MO.6 1is set 3.0 & s1
R 0]
MO.2 ;Second time Marker is set
MO.6 ;and T2 Marker is set M0.2 — &
M2.0 ;jand second step Marker is set MO.6 —
MO.4 ;or fourth time Marker is set M2.0 - =1
MO.7 ;and T3 Marker is set
M2.0 ;and second step Marker is set
. . MO.4 —
00.1 ;Pedestrian green signal off MO. 7 & MO. 3
MO .0 ;Reset Request Marker M2.0 -
MO.2 ;Reset second time Marker T 1 T IR1
MO0.3 ;Reset counter Marker S Q
MO.4 ;Reset fourth time Marker
MO.6 ;Reset T2 Marker MO.4
MO.7 ;jReset T3 Marker
M2.0 ;Reset step Marker 2 —| R1
S Q
MO.6
- R1
R Q
MO.7
— R1
S Q
M2.0
— R1
S 0
MO.0
— R1
S Q
00.1
I R1
R 0
MO.2
‘— R1
S Q
EM
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Loading, testing and modifying
the program

Download the program to the
controller with ”Controller ->
load”. Now open the Monitor
and test the program by setting
and enabling 10.0 six times.
However, repeat this sequence
only once or twice.

You should now make a few
changes in the program in
order to familiarize yourself
with WinSPS and the CL150.

Open the Editor again.

A Edit |

Slightly modify the program and
reload it to the controller.

You can, for example, extend or
reduce times; or, you can add
comments to disable markers
that, on first sight, appear to you
to be superfluous. The program
process will then be different -
monitor the reactions in the
Monitor and find out why the
program reacts this way.

In short, feel free to play around
with the program. Maybe you

will come up with a solution you
like better than the existing one!
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Structured
programing

Structured programming is used
to split the program into clearly
organized, functionally and
technologically interrelated
modules for your PLC
configuration.

Each one of the modules carries
out a partial operation in the
PLC configuration.

The advantages of structured
programming are:

e a clearly organized program
structure,

¢ programming and testing of
subroutines,

e testing and editing of PLC jobs

by the project team members
¢ multiple use of program
modules
e simplified troubleshooting
e clear readability
e shorter programs

Module call with parameters

Organization Modules and
Program Modules are available
to realize structured program-
ming.

Organization Modules (OM:s) are
called directly by the CL150
operating system. Therefore, they
are mainly used for jobs closely
related to the system.

The tasks of Organization
Modules include error/interrupt
handling, initialization of the
CL150 and cyclic processing of
the PLC program.

Input parameters are passed to the program module when it is called.
The subordinate module returns the results in output parameters.

WinSPS manages

Input parameters VAR _INPUT
Output parameters VAR _OUTPUT
I/0 parameters VAR_IN_OUT

The number of parameters is returned when the module is called.

;Module call

cM FC1,2
PO M1.1
P1 W M20

;Module FC1

A 10.0
AN PO
= 00.2
L W P1,A
INC W A,1
T W A,P1

The PLC program is edited in
the program modules.

Each one of the program
modules should describe a
functionally interrelated task.
It can call up further program
modules to process part of this
task.

Program modules can be
configured. When the module
is called, the data required by it
is passed as parameter value.

With the documented parameter
values acting as interface, the
modules can be encapsulated and
inserted in the module library.
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Structuring the

control program

The network of a sample
program shows you how to
configure and call a module.
The crossover light function is
not changed in this process.

We shall use Network no. 3
“Time delay red -> green”.
The master program calls and
transfers the timer function and
the parameters to a separate
program module.

Customizing the
symbol file

In the symbol file, you must
specify the new program module
you are using for this
configuration.

The new module will be called
“timerl.pxo”.

Enter the following row below
the row calling the module
”programl.pxo”

FC1,R TIMER1

Save the symbol file.

Configuring a module
First, we shall create the program
module "timer.pxo”.

[

This program module is to be
called with three parameters.
First, create the new module and
then customize your parameter
data.

timer1.pxo

You can edit the parameters in a
separate window of the WinSPS
Editor under “Edit -> Edit
Parameter List...”.

Input data for the parameter
header:

PO Bool Step Marker 1
VAR INPUTP
P1 Bool Request Marker
VAR INPUTP
P2 Bool Time_ Marker 1

VAR OUTPUT

The new program module "timeri.pxo”

Network 1, Timer for red > green delay

The new program module
“timerl.pxo” consists of two
networks

\\l\ 1 Timer for red-green

delay

\”|\

Copy network 3 from the
module "program1.pxo” to the
new module and replace

2 Module end

MO0.0 with PO
M1.0 with PI and
MO.1 with P2.

Save the completed module
“timerl.pxo”.

A PO ;Request marker is set T1
A Pl ;and step marker 1 is set PO —f & SRE
L W T#10s,A ;10 seconds period p1
SRE A,T1 ;Rise-time delay — IN ET
L W T1,A ;Load time
. — PT
A Tl ;Time running? T#10s ST
= P2 ;First timer marker is set R _
jif T1=1 09— = 2
Network 2, Module end
EM EM
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Customizing the
program module

Subsequently, insert the
parameter list by selecting
"Edit -> Call parameter list”.

“program1i.pxo”

Now the first program module
”programl.pxo” remains to be
customized:

WinSPS queries the parameter
list in module ”timerl.pxo” and
inserts it with its symbolic
operands.

Delete the contents of Network 3  Replace these symbolic operands

without deleting the network

itself.

AN

CM

Pl
P2

CD

L W
SCY

EM

with the absolute parameters
MO0.0, M1.0 and MO.1.

MO.0 ; Request Marker off

00.0

s1

MO.0

sl

M1.0

s1

MO.5

S1

—MO0.3

00.0 ; Crossing signal red
d d MO.0 &

00.0 jPedestrian crossing signal is red and

I0.0 ;Request button actuated and 00.0 — &
MO0.0 ;jRequest Marker not set 10.0 —
MO.0 ;Set request Marker MO.0
M1.0 ;Step Marker 1
MO.5 ;Marker is set

Network 3, time delay red > green via module call
FC1,3

MO0.0 ;i VAR_INPUT

M1.0  ;VAR_INPUT

MO.1 ; VAR_OUTPUT

00.0 jPedestrian crossing lights red Cl
I0.0 ;Request button actuated 00.0 —I & CD
Cl jCounter = Counter - 1 10.0—

MO.5 ;Marker is set — CD
4,A ;Load counter status 4 v
A,Cl ;Set counter 4 £§
Cl,A ;Transfer counter to A MO.5

c1 ;Counter 1 not 0 | Counter 1 = 0 R 0
MO.3 sM0.3 = 1 | M0.3 = 0

EM
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Memory structure

The CL150 is equipped with
RAM and Flash EPROM

memory modules.

The RAM area is a volatile read-
write memory that must be
battery buffered to protect
against power failure, thus
protecting against the loss of

the PLC program and remanent
data.

EPROM memory is non-volatile,
which means that program and
data modules loaded to the
EPROM are still available after
a power failure. However, the
actual data of remanent areas
and of the data field are lost if
no buffer battery is installed.

CL150 operating modes

The CL150 operates in two
modes: with and without battery.
In battery mode, all memory
data and the setting of the
real-time clock are retained
when the power supply is
switched off. After the power
supply is switched on again the
controller picks up operation
with the values contained in the
memory before power was
switched off.

With operation without battery,
the RAM and data memory
restart in an undefined state after
power is switched on again. The
real-time clock is set to 01.01.00 /
00:00, the weekday is not
defined. All modules contain
their initialization values. User
data are deleted.

You declare the operating mode
of the CL150 in the Initialization
Flag DW02.bit 7, of the
Initialization Module OM2:

DWO, bit7=0
DWO, bit 7=1

no battery
battery mode

Delivery state of the CL150:
no battery mode.

111

{poooooocpoooooogiood

Remanent behavior

The CL150 provides a remanent
memory area for storing operand
values. The memory is battery
buffered and protects data in case
of power failure and operating
mode transitions Run/Stop and
Network On. This remanence
area can be modified in OM2.

Without changes in OM2, the

remanent memory area contains:

Marker M76 to M152
Counter C32 to C63
Times T64 to T127

The complete Data Field, Data
Modules and Monitor Fixings
also stay remanent.
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()
CL150 startup modes EmmE |
The CL150 can load new After it is switched on, the If a program exists there
programs from EPROM CL150 first tries to locate a the CL150 loads it into the
memory, independent of valid program in the RAM or RAM.
a programming device. EPROM memory.

Load program

_: T

n

yes
Jl
s

= T )
|
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In the CL150 controller you can
utilize two fast hardware counters
or, as an alternative, three
interrupt inputs. The controllers
CL150A and CLI151A can be
used to process analog values.

EFHCL150 interfaces

Onboard

hardware counters

These are two fast 32-bit
up/down hardware counters.
They can count pulses, regardless
of the PLC I/0 cycle. Both
counters can process their own
tasks. You can configure 10.0/
10.1 and 10.2/10.3 as fast
counters.

The default setting of both
counters is specified in the
Organization Module OM2.
When using these counters
you must implement this
Organization Module in the
PLC program.

Declared is

o the counter default values,

e an upper and lower setpoint,

e outputs to be set
instantaneously after the
setpoint is reached,

e control data for edge detection
and default count direction.

Inputs
X21B
RINRINEEEE

H$$¢DDDD

|

‘I0.3: Count direction Counter 1
10.2: Clock input Counter 1

10.1: Count direction Counter 0
10.0: Clock input Counter 0

Interrupt inputs \4

With the help of the three alarm/
interrupt inputs 10.0 to 10.2 the
PLC can react instantaneously,
regardless of program signal
transitions at the input.

An input signal transition from
0 to 1 triggers a peripheral
interrupt in the PLC. This
interrupt stops the current PLC
program process and starts one
of the three Organization
Modules OM10, OM11 or
OMI12.

This input function is enabled
if the interrupts are enabled
and if OM10 to OM12 are
implemented in the program.

One Organization Module is
assigned to each interrupt input.
The first input has the highest
priority. This means that the
program in Organization Module
OMI10 can not be interrupted by
an interrupt of the second or
third input.

The PLC program continues
at the break point after it has
processed the interrupt request.

—
E [
S

Analog data

X2
processing

The CL150A and CLI151A are
equipped with two analog inputs
and one analog output. Without
additional modules they can
therefore process measuring data,
for example, for monitoring
temperature, filling levels and
pressure or tasks for controlling
motor controllers or slide valves.

The analog signals are connected
to the X23/X24 interfaces. These
analog inputs operate with a
resolution of 10 bits and in a
voltage range of 0 to 10 V.

At the analog output the signal is
made available on two cables as
voltage value (X12) or current
value (X13). The nominal range
of the voltage signal is 0...10 V
or -10...4+10 V, that of the current
signal is 0...20 mA.

The system area of the controller
contains the data for analog data
processing.

‘IO.Z: Interrupt 2, call OM12
10.1: Interrupt 1, call OM11
10.0: Interrupt 0, call OM10
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Technical data of the CL15x, CL15xA

Classification :
Control systems of the lower and
medium performance class

Module rack dimensions (WxHxD)

inmm 123/184 x 105 x 38
without connectors

Weight 350 g / 80 g
24-V voltage supply

Current consumption up to 1.2 A,

inrush current up to 25 A

01

23,
5570123456
7
24v.

S50 _xa1,

Editing time

Bit instruction min. 0.6us
Word instruction min. 0.6s
Module instruction min. 46 ps
I/0 image in 0.6 to 1.9 ms

64 KB RAM program memory

and
64 KB Flash EPROM

RAM buffering with lithium battery

Cl1s
1070080502

X
5
1

12 Organization Modules,
OM1 to OM3, OM5, OM7,
OM9 to OM12, OM17 to OM19
128 Program Modules,

FCO to FC127

128 Data Modules,

DMO to DM 127

8 kByte Data field,

DFO to DF8191

256 bytes system area,

S0 to 8255

Nesting depth

32 blocks

7 bracket levels

Address format: BIT, BYTE,
WORD, DOUBLEWORD for

constants

384 digital inputs
10.0 to 147.7

256 digital outputs,
00.0 to O31.7
1216 Markers,
MO0.0 to M151.7

4 registers, Word length
128 timers,

TO to T127

64 counters,

CO0 to C63

2 fast counters,

32 bits, max. 10 kHz
Analog inputs:
CL15xA: 2

Analog outputs
CL15xA: 1
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Bosch CL150, CL151,
CLI150A, CL151A

-DP, -CAN, -IBS, -DEV
Controller Manual /
Operation List

Order no. 1070 072 188

D

.. 92 %
Training 909

The Bosch Training Center
”AT-didactic” offers product
training related to the economic
use and operation of industrial
controlling techniques.

¢ Programmable Logic
Controllers (PLC)

Numeric Controls (CNC)

Robot Controls (RC)

Electrical Servo-drive systems

Welding controls

You can order the detailed
training program by calling
Germany +49 (0) 60 62 / 78-6 02
or per

fax +49 (0) 60 62 / 78-8 33



Glossary

Absolute Jump

AND circuit

ASCII

Battery RAM
Baud rate

Binary

Bit
Byte

Central unit

CPU

Compare function

Conditional jump

Contact plan, LAD

Cross-reference

Cycle time

Editor

EPROM

F ixing

Function block language, FBL

Hardware

Input image

Instruction

Instruction List, STL

Interrupt input

The jump is carried out regardless of the previous logic link
result. See also Jump Instruction.

Serial logic contact link. The logic result is only 1 if all contacts are on
current, that is, if all contact signals are 1.

American Standard Code of Information Interchange -
standardized code for character display

Read / Write Memory. Buffered against power failure.
Dimension for the speed of data transfer

Numerals, data and information are displayed only with the
characters 0 and 1.

“1“

Smallest unit that describes a “0“ or status.

1 Byte = 8 bit

The PLC core - consists of the controlling unit and the
calculation unit

Central Processing Unit — see Central Unit

Logical or arithmetic comparison of operands
(BIT, BYTE, WORD etc.)

The jump is only carried out if the previous logic link result is 1. See
also Jump Instruction.

Represents the control sequence with NO and NC contacts as common
in relay technology.

Determines all blocks and program rows for an operand which is
used in the PLC program.

Time required for one cycle of the user program

User program which assists the following actions: input,
modification, correction, saving and output of PLC programs.

Erasable Programmable Read Only Memory. The memory
content is non-volatile. However, it can be erased if required.

Setting or resetting I/Os with the help of a programming device,
regardless of the respective program dependent I/0O status.

Function block representing logical networks.

All devices and accessories of a PLC, for example, the
programming device, controller, printer, cables etc.

Memory for the “0” or “1“ status of all PLC inputs

The smallest self-contained step of a PLC program, for example,
1/0 links AND, OR etc.

Presentation of a PLC program in which the instructions are
listed in rows one below the other.

Input with the highest priority. When the interrupt input is set,
the normal program cycle is interrupted to process an interrupt
routine.
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Jump instruction

LED

Marker

Marker area

Monitor mode

N ormally closed contact (NC)
Normally open contact (NO)

O ffline

Online

Operands

Operation

Optocoupler

OR circuit

Output, short circuit-proof
Output image

Output signal

P eripheral devices

PLC

Potential separation

Program
Program address

Program memory

64

With a jump instruction the user can force the PLC program
to quit at a defined point and perform a jump to continue
program processing at another point of the program. There
is a differentiation between absolute and conditional jump
instructions.

Light Emitting Diode - Luminescent diode optically displaying
operating states

Memory for intermediate values with the status Set or Not Set.

Number of available markers. The CL150 is equipped with a
marker area of 152 markers

Displays internal and external switching states on the
programming device. See also Online.

Breaks the current circuit when it opens.

The current circuit is connected when this contact closes.

The programming device is not connected to the PLC.
PLC programs can be created without the controller.

The programming device is connected to the PLC. While the
machine or system which is to be controlled is in operation, the
I/0 status and the logic link results can be monitored on the
programming device. See also Monitor mode.

This refers to inputs, outputs, markers, timers and counters.
Addresses are part of the instruction set.

Part of the control instruction set which determines how to
interlink operands, for example, with AND, OR, LOAD,
ADD, COMPARE operations.

Module for the separation of current circuits. The electrical
signals of the primary current circuit are converted into a light
signal. These signals are subsequently converted back into the
original electrical signal in the secondary circuit, thus decoupling
the secondary current circuit from the primary. This increases the
PLC’s immunity to interference.

Parallel logic link of two contacts. If one of the contact

signals = “1%, it is under current, the logic resultis a 1.

Output on which the output current is retained within permitted
limits in error case.

Result memory for logic link results that are passed to the outputs
at the end of a PLC program.

Current/voltage value for controlling series control units, power
contactors, motors or valves.

All devices which can be connected to a PLC; for example,
printers or text displaying devices

Programmable Logic Controller

Distribution of I/0O signal lines to multiple current circuits with
multiple reference points.

Command set for the solution of certain tasks.
Identifier of program segments

Semiconductor modules for storing user programs; for example,

EPROM or RAM.



Program processing controlled
by interrupt

Ram

Remanent memory

Serial interface
Software
STL

Transfer protocol

The interrupt routine OM10, OM11 or OM12 is processed when
the interrupt input is set. This interrupts cyclical PLC program
processing.

Random Access Memory - Memory module for read / write
operations. The memory is volatile in case of power failure if
not battery buffered.

Non-volatile memory. The content is remanent in case of power
failure.

Transmits serial data over a single data line
Collective term for programs

See Instruction List

Standardized protocol for data communication. The data format
and parameters of the communication are fixed. The aim is high
communication reliability.
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Index

A

Absolute Addresses, 31
Address areas, 38
Addressing BIT operands, 37
Addressing, 11

Alerts, 19

Analog value processing, 60
Arithmetic functions, 35

B

Basic device, 8, 9
Battery mode, 58
Binary commands, 30
Bracket functions, 31
Buffer battery, 58

C

Checking the data
communication, 15
Comment header, 19
Comments, 27

Compare instruction, 35
Connecting a data link, 15
Connection X31, 15
Constants, 38

Controller variants, 8, 9
Copy key, 59

Counter instructions, 32
Creating a file, 20

Creating a PLC configuration, 16
Creating networks, 20
Cross-reference lists, 27
Customizing communication
parameters, 15

D

Data Field, 39
Data Modules, 39
Data transfer, 15
Disruption of data
communication, 15

E

Editor, 17

EPROM memory, 58
Error abbreviations, 19

F
Fieldbus interface, 8

File structure, 16

Fixing, 48

Flash EPROM memory, 58

H

Hardware counter, 60
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Indirect addressing, 37
Installation program, 14
Installing WinSPS, 14
Instruction overview, 28, 29
Interface testing, 15
Interfaces, 60

Interrupt input, 60
Interrupt input, 60

L

Licensing WinSPS, 14
Literature, 62

Load instruction ”L”, 35
Loading the program, 59
Logical link result (VKE), 30
Logical links, 30

M

Memory structure, 58
Module interface, 7
Module library, 55
Module rack, 7
Monitor, 23

N
Network, 30

0

Opening a file, 20
Operand address, 36
Operand field editor, 25
Operand status, 25
Operating modes, 58

S

Serial interface, 15
Stack processing, 27
Start address, 11
Startup modes, 59
Status bit, 35
Symbolic names, 31
Symbolic operands, 31
System status, 24

T
Technical data, 61

Testing the program, 26
Time constant, 33

Time diagrams, 33

Time instructions, 33
Training, 62

Transfer instruction ”T”, 35

U
Uninstalling WinSPS, 14

Vv

V24 cable K19, 15
Variable types, 38
Voltage supply, 10

w
WinSP overview, 13
WORD operands, 36

Operating without battery, 58
Organization Module OM1, 19
Organization Modules, 39, 55

P

Parameter call, 55
Peripheral interrupt, 60
PLC program in FBS, 20
Preset, 16

Printing, 27

Program Modules, 39, 55
Programming times, 33
Programming, 19
Project directory, 16
Project path, 16

R

RAM memory, 58
Register, 35

Remanence behavior, 58
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